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1. Qué és Mendeley?

Es una eina que combina diversos aspectes: un gestor de referéncies bibliografiques, una xarxa
social academica i un cataleg col-laboratiu de literatura cientifica.

Us permet guardar referencies bibliografiques, gestionar-les, utilitzar-les en treballs i bibliografies i
compartir-les amb altres usuaris. També us permet descobrir nova recerca, crear grups privats per
col-laborar amb col-legues d’investigacid i guardar dades associades a la vostra recerca (Mendeley
Data).

Mendeley Institucional (MIE) és la versid que la UAB ofereix a tota la comunitat universitaria. Aquesta
ofereix prestacions superiors a les que ofereix un compte amb la versié gratuita de Mendeley. Més
informacié a https://www.uab.cat/ca/biblioteques/gestors-bibliografics

u Si deixeu de tenir vinculacié amb la UAB no podreu mantenir el vostre compte MIE. Les condicions
que tindran els alumnes ja graduats (exalumnes o alumni) son les prestacions de Mendeley free. Si durant el
temps que han estat a la universitat s'han fet usuari MIE, disposaran de 12 mesos amb beneficis d’'un compte
MIE. Transcorregut aquest temps Mendeley avisara I'usuari que ja no forma part del col-lectiu MIE perqué
prengui les decisions oportunes. Recomanem que, abans de deixar la universitat, els usuaris s'assegurin que en la

configuracié del compte hi consta I'adrega de correu personal com a adrega principal en lloc de la universitat.
Més informacié: http://www.uab.cat/doc/MendeleyAlumni
uGuies i videos d’ajuda a:
https://www.mendeley.com/advisor-community (Apartat Teaching materials)
https://www.mendeley.com/guides
https://www.uab.cat/ca/biblioteques/gestors-bibliografics

2. Accés

La UAB ofereix accés a Mendeley institucional als membres de la comunitat universitaria. Per gaudir
dels avantatges institucionals, cal accedir a I'eina a través de la universitat:

1. Accediu a la pagina oficial de Mendeley: https://www.mendeley.com

2. Ala part superior dreta de la pantalla, teniu 2 opcions:

2a. Create an account: seleccioneu aquesta opcid si no teniu cap compte de Mendeley i voleu
registrar-vos.

2b. Sign in: trieu aquesta opcid si ja teniu un compte gratuit de Mendeley i voleu actualitzar-lo a
la versid institucional.

3. Entots dos casos, es demana que se seleccioni Sign in via your organization, que es troba just
sota el camp per introduir el correu electronic. No cal que introduiu el vostre correu electronic en
aquest moment.

4. Cerqueu Universitat Autonoma de Barcelona: quan comenceu a escriure, apareixera un menu
desplegable amb diverses institucions. Seleccioneu la UAB i feu clic a Submit and continue.


https://www.mendeley.com/
https://www.uab.cat/ca/biblioteques/gestors-bibliografics
https://www.mendeley.com/guides
https://www.uab.cat/ca/biblioteques/gestors-bibliografics

10.

11.

12.

UA Universitat Autonoma
de Barcelona
Serveide

Biblioteques

Guié: Mendeley Juliol 2025

La seglient pantalla us demanara si voleu accedir a Mendeley amb les vostres credencials de la
UAB o com a usuari convidat. Trieu I'opcid d’accedir a través del vostre usuari UAB i inicieu la
sessio utilitzant el vostre NIU i contrasenya.

Configureu o actualitzeu el vostre compte de Mendeley:

6a. Si no teniu cap compte de Mendeley, haureu de proporcionar les vostres dades personals i
académiques per crear-ne un.

6b. Si ja teniu un compte gratuit de Mendeley, inicieu la sessid amb les vostres credencials per
transferir-lo a la versié institucional.

Com que heu iniciat la sessié a través de la UAB, Mendeley reconeixera el vostre dret d’accés
institucional.

Un cop dins del vostre compte Mendeley, aneu a la part superior dreta de la pantalla i cliqueu
sobre el vostre nom d’usuari.

Trieu I'opcid Settings del menu desplegable, i després I'opcié Subscription que apareix a
I’esquerra de la pantalla. Veureu que a la pantalla Subscription ja s’identifica el vostre compte
amb les prestacions Mendeley Institutional Edition.

A partir d’aquest moment, podreu accedir al vostre compte Mendeley des de qualsevol
ordinador amb tots els avantatges d’un compte MIE.

Aqguest accés sera valid durant un any. Durant aquest termini, podreu treballar amb Mendeley
gaudint dels avantatges del compte institucional entrant directament a
https://www.mendeley.com.

Quan acabi aquest termini d’un any, rebreu un missatge on es demana que, si seguiu pertanyent
a la comunitat UAB, renoveu el vostre accés institucional. Per renovar-lo, simplement torneu a
iniciar sessid a través de I'opcid Sign in via your organization.

3. Doble plataforma: Mendeley Reference Manager i Mendeley web

Mendeley té dues plataformes: Mendeley Reference Manager i Mendeley web

3.1. Mendeley Reference Manager

Es I'aplicacié d'escriptori per la gestié de les referéncies i la creacié de bibliografia. Des d’aquesta
interficie podreu guardar, organitzar les vostres referéncies, citar i col-laborar amb altres usuaris a
través de grups privats. Podeu descarregar-la des de https://www.mendeley.com/download-
reference-manager/



https://www.mendeley.com/
https://www.mendeley.com/download-reference-manager/
https://www.mendeley.com/download-reference-manager/
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Mendeley Reference Manager

Mendeley Reference Manager File Edit Tools Help 1

+ Add references All References 7 | Q Search = Filters m View

[ ] AUTHORS YEAR TITLE
I\ All References o
® Recently Added [ He, Lin; Nahar, Vinita 2016 Reuse of scie
[l Recently Read |:| ® ¢y Watanuki, Shinya 2024 Aesthetic eva
i Fhinles 4 |:| Vila Sanchez, José Antonio 2020 Javier Marias
Ol mMy Publications -
) [] <+ Vila Sanchez, José Antonio 2020 Javier Marias
& Unsorted
& Duplicates [ Vila Sanchez, José Antonio 2020 Javier Marias
[ Trash |:| v Calvet, 3 Como vivir co
Hitezmmall 5 |:| <%+ Bravo San José, Montserrat 1989 Los Parlamen
Neuromarketing - _ . ) .

[] <% Mansor, Aida Azlina; Isa, Salmi Mohd 2020 Fundamentals
® Create collection

(] iy Bhardwa], Shikha; Rana, Gunjan A.; Behl... 2023 Exploring the
GROUPS 6 _

. B v Watanuki, S 2025 Aesthetic eva

Biblioteca de Comunicacid i U i '
@ Create group (] <% Usman, 8 M: Khalid, 8: Tanveer, A Imran... 2025 Multimodal ca

1. Barra de menus: només visible a Mendeley Reference Manager

2. Notebook: pagines que podem anar creant per prendre notes generals. Les notes sobre cada
referencia van a Annotations

3. Sincronitzacio

4. Col-leccions per defecte

5. Col-leccions creades per l'usuari

6. Grups

7. Cerca

8. Referencies de la vostra biblioteca

3.2. Mendeley Web

Accediu a través de la pagina web www.mendeley.com
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AR Mend

Welcome to Mendeley

Search for and add articles to your library

eley

Search for articles...

Search

>

Library | 2 :

Try: COVID-19 | Bicenergy | Obesity trifisic Motjration, o O™ O
Try the desktop app to manage your library
- ]
Download Mendeley Reference Manager ~
o
i' & = 0
-
=
:f__ 0

Mendeley Supports Responsible Sharing > Learn how you can share

4 5 6
Products Support About Us Downloads
feference Management Help Guides About Us Reference Manager
Diatasets Citation Guides Work at Mendeley Web Importer
Premium Packages Support Center Contact Us Citation Flug-in

Release Motes Accessibility
Blog

Advisor Community
Developers

Privacy Principles

1. Search: permet cercar al cataleg col-laboratiu de Mendeley
2. Library: gestio de referéncies, carpetes i visor de PDF
3.Perfil personal: Aqui trobeu I'opcio Settings amb algunes pestanyes d’interes: Account (canvi de
dades personals i paraula de pas), Subscription (Aqui podeu veure que esteu subscrits a Mendeley
Institutional Edition, el vostre espai personal, I'espai compartit i els grups que heu creat),
Notifications (Podeu seleccionar les notificacions que voleu rebre de Mendeley)

4.Products: Premium packages (per si voleu ampliar el vostre espai d’emmagatzematge) i
Datasets (repositori gratuit de dades de recerca. Podeu trobar una taula comparativa de
repositoris a: ddd.uab.cat/record/150829)

5.Support: accés a guies i centre d'ajuda
6.Downloads: permet descarregar les eines Reference Manager, Web importer i Mendeley Cite.


file:///C:/Users/2114845/Downloads/ddd.uab.cat/record/150829
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uTot i que la interficie de les versions web i desktop (Reference Manager) és casi idéntica, hi ha algunes
prestacions (com Watch folder) que només es poden realitzar des de la versié desktop. Ho trobareu indicat
en aquesta guia

nLa sincronitzacid entre les dues versions es fa de manera automatica cada vegada que us connecteu, o
feu un canvi (afegiu una referencia, I'esborreu, feu una anotacio...). Aixi i tot es pot executar quan vulgueu

a través de la icona CD

4. Creacid d’una biblioteca personal

4.1 Importacio mitjancant Web Importer

Web importer és un complement que us permet importar referéncies i PDF des del web. S’ha
d’instal-lar al navegador seguint les instruccions de la pagina www.mendeley.com/reference-
management/web-importer/. Es compatible amb el Cercador de les biblioteques de la UAB, diverses
bases de dades (Science Direct, PubMed, Scopus), revistes digitals, alguns catalegs (com el CCUC) i
varietat de webs (Viquipédia, Google Scholar, etc.)

O c|lB|lD O

M Mendeley 1 X

Select Al Neuromarketing 3| v

Defining neuromarketing: Practices and
professional challenges

Carl Erik Fisher, Lisa Chin et al.

Harvard Review of Psychiatry, 18, 4, 7 2010

@ PDF not found

What Can Neuromarketing Tell Us about
Food Packaging?

Ingrit Moya, Jests Garcfa-Madariaga et al.
Foods (Basel, Switzerland), g, 12, 12 2020

View PDF

Neuromarketing and Al—Powerful
Together, but Needing Scrutiny 4
Paul Root Wolpe

AJOB Neuroscience, 10, 2, 4 2019

View PDF -

View Library


http://www.mendeley.com/reference-management/web-importer/
http://www.mendeley.com/reference-management/web-importer/
http://www.uab.cat/biblioteques
https://ccuc.csuc.cat/discovery/search?vid=34CSUC_NETWORK:CSUC_CCUC_UNION
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1. lcona al navegador per accedir al Web importer
2. Documents recuperats. Web importer permet descarregar les referéncies d’'una en una o totes

les de la pagina que esteu visualitzant.
3. Triar la carpeta de desti. Abans de descarregar les referéncies les podeu editar i modificar clicant

a sobre i afegir-les a una carpeta.

4. En alguns casos podreu importar els PDF associats a les referéncies. Marqueu l'opcié Add PDFs
if available a la configuracié de Web Importer. Hi accedireu a través de la icona ==+
Si no podeu importar el PDF, els podeu guardar al vostre ordinador i posteriorment incorporar-
los mitjangant Drag and Drop o des de la columna de la dreta (visualitzacié de la referéncia) a
I'apartat Files. Si incorporeu una referéncia i el seu PDF per separat el sistema els uneix.

4.2 Importacié mitjangant Drag and Drop (arrossegar i deixar anar)
Permet incorporar a la versié web (Library) o desktop (Reference Manager) referéncies i PDF des de:

e Bases de dades i revistes digitals que no admeten el Web importer. Haureu de fer una
exportacio indirecta guardant el fitxer de text (preferiblement en format RIS) al vostre

ordinador i després arrossegar-lo.

e Referéncies provinents d’altres gestors (Zotero, Refworks). Es fa de manera similar; exporteu
els registres, en format RIS, des de Refworks o Zotero. Guardeu el fitxer al vostre ordinador i

arrossegueu-lo.

Les dues importacions anteriors també es poden fer des de +Add references = Import library

—>RIS.

e PDF que tingueu al vostre ordinador (provinents de bases de dades). Podeu importar un o
diversos PDF alhora, seleccionant-los i arrossegant-los. També ho podeu fer des de +Add
references = Import file(s) / Import folder(s).

n Altra opcié d’importacié és mitjancant Watch Folder que permet que el sistema importi
automaticament els documents en PDF que teniu en una carpeta del vostre ordinador. Els documents
s’incorporen a la carpeta All References. Ho podeu fer només des del Reference Manager a File > Watch
folder. Més informacié a Adding references

4.3. Importacid des del Cataleg col-laboratiu de Mendeley

El cataleg col-laboratiu de Mendeley s’alimenta de les referéncies que inclouen els usuaris

Podeu cercar a Mendeley Web clicant sobre Search

Search for and add articles to your library

Search for articles...


https://www.mendeley.com/guides/mendeley-reference-manager/02-adding-references
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A més d’'importar la referencia, Mendeley ofereix I'enllag extern a la pagina de 'editor. Hi podreu
accedir al text complet de I'article si és un recurs d’accés obert o si esta subscrit per les Biblioteques
de la UAB i si esteu connectats a la xarxa de la UAB.

Cada referéncia mostra el nombre de citacions rebudes (que s’obté de la base de dades Scopus) i el
nombre d’usuaris de Mendeley que tenen aquesta referéncia al seu compte. Aquestes dades sén
recollides per PlumX, un agregador de métriques que és considerat per les entitats financadores
(Aneca, Aqu) en I'avaluacio de la recerca. Per tant, si sou investigador potser us interessa tenir les
vostres publicacions al Cataleg col-laboratiu de Mendeley.

Els PDF que pugueu trobar en aquests enllagos no s'importen directament a la vostra Biblioteca. Cal
descarregar-los posteriorment clicant a la icona View PDF

uPodeu excloure una referéncia per tal que no formi part del Cataleg col-laboratiu de Mendeley.
Per excloure-la aneu a la visualitzacid de la referéncia i desmarqueu I'opcié:

Share reference anonymously with Mendeley Web Catalog

uAI Reference Manager podeu consultar el Cataleg Col-lectiu de Mendeley des del menu Tools
-> Search for articles online, que obre la cerca a la versio web.

nSi teniu una bibliografia feta amb el gestor de referéncies bibliografiques del Word o una
bibliografia sense formatar podeu importar-la a Mendeley fent servir una eina que es diu
AnyStyle: https://anystyle.io/. Un cop teniu les referéncies guardeu-les en format BibTeX i
exporteu-les a Mendeley per exemple amb Drag and Drop.

4.4. Introduccio manual de referéncies

Aneu a la icona Add References = Add Reference Manually. Si teniu el DOI o altres nimeros
identificadors (ArxivID i PMID), podeu posar-ho al camp Identifiers i Mendeley omple

automaticament les dades de la referencia. Molt Gtil també per completar dades de referencies que
heu importat.

5. Gestionar col-leccions i referéncies

A Mendeley les referéncies s’organitzen per Col-leccions

5.1. Gestionar col-leccions
5.1.1. Col-leccions per defecte de Mendeley Reference Manager

e All references: totes les referéncies. Si cliquem a la icona dels 3 punts "'* podem escollir
Make Available Offline que crea una copia de les referéncies al nostre ordinador de manera
que podem treballar amb elles sense connexid a Internet.


https://anystyle.io/
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e Recently added: ultimes referéncies afegides

e Recently read: ultims documents llegits

e Favorites: referéncies marcades com favorites i<

e My publications: podeu afegir en aquest apartat les vostres publicacions, per tal que les

pugueu gestionar

e Unsorted: referencies que no hem posat en cap col-leccié creada per nosaltres

e Duplicates: referencies que el sistema marca com duplicades

e Trash: des de la paperera podeu esborrar definitivament les referéncies o restaurar-les

5.1.2. Crear, reanomenar i esborrar col-leccions
Des de la columna Collections > Create collection. Un cop creada la col-leccid, clicant sobre el
nom amb el botd dret del ratoli trobareu les segiients opcions:

Rename

Make Available Offline

Delete Collection

BibTeX (*.bib)
EndNote XML - EndNote v8, X1 to X3 (.xml)
Microsoft Word (*.xml)

RIS - Research Information Systems (*.ris)

New Sub-collection

e Rename: per canviar el nom

e Make Available Offline: ens permetra treballar amb les referencies sense estar
connectats. Aquesta opcid només esta disponible des de Reference Manager

e Delete Collection: esborra la col-leccid pero no les referencies que van a All references

e Export as: ens permet exportar les referéncies en diferents formats

e New Sub-collection: Per fer una col-leccié subordinada a una altra

5.1.3. Copiar, marcar favorits, exportar i esborrar referéncies

e Per copiar referéncies en una col-leccié determinada, cal seleccionar-les. En aquest
moment s'activen les segiients icones que trobareu al final de la pantalla.

Organize v Mark as v

Copy as v

Export v Move to Trash
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e Organize: podeu triar la col-leccié o grup de desti
e Mark as: marcar i desmarcar referéncies com a favorites o els PDF com llegits
e Export: els formats d’exportacio son .ris, .bib i .xml

e Move to Trash: esborrar les referéncies, que passen a la col-leccié Trash

uPer exportar totes les referéncies de la biblioteca, des de Reference Manager, aneu al mend File 2
Export all. Només exporta les referencies, no els documents adjunts

5.2. Buscar i editar referencies

5.2.1. Editar referéncies

e Ordena les referencies per: autor, titol, any, titol publicacié, data afegit a Mendeley i si les
referéncies contenen fitxers adjunts.

AUTHORS YEAR TITLE SOURCE ADDED FILE

e Editar una referéncia: seleccioneu una referéncia. A la dreta s'obre una finestra i podeu editar els
camps i afegir els vostres propis tags (paraules clau). També disposeu de les pestanyes
Annotations i Notebook

Info Annotations MNotebook

Annotations: notes generals associades a una referéncia o notes fetes al PDF d’aquesta
referencia (Comments)

Notebook: Es un bloc de notes no vinculat a cap referéncia especifica. Només esta actiu a la
vostra biblioteca personal, no funciona amb els grups privats. Util per agafar notes d’un o
diversos PDF; si amb un PDF obert seleccionem i destaguem una part del text quan cliqguem a
sobre el podrem afegir al Notebook.

Change color

ONONONONONG)

{7 Add to Notebook

i Delete Annotation

10
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5.2.2. Buscar referéncies. Filtres

Seleccioneu All references si voleu fer la cerca a tota la biblioteca o una col-leccié en concret i

cerqueu des del desplegable situat a la part superior dreta. Teniu I'opcid de fer servir filtres per

refinar la cerca.

Q, Search

= Filters

u La cerca es fa sobre els camps de la referencia i sobre el text complet dels PDF.

5.2.3. Gestid de duplicats

Mendeley pot detectar registres duplicats sempre que tinguin DOI. Crea, automaticament, una
carpeta anomenada Duplicates. Podeu accedir a la carpeta des de la columna de I'esquerra, o bé
des de Tools > Check for duplicates.

Us apareixeran els duplicats agrupats. Només heu de decidir quin registre deixeu i quin elimineu.

12 sets of duplicates with the same DOI

This set contains 2 duplicates of the same reference

1 Watanuki S

2 Watanuki S

Aesthetic evaluation underpinning brand love relationsh... 2025 FRONTIER... Added 4/3/2025

Aesthetic evaluation underpinning brand love relationsh... 2025 FRONTIER... Addec

Keep this reference only

Move reference to Trash

5.3. Visor de PDF. Notes personals

Mendeley Reference Manager té un visor de PDF que permet crear notes, copiar una part del text i

destacar contingut dins documents PDF.

Accediu al visor clicant a la icona de color verd

del panell de la dreta.

, fent doble clic sobre la referéncia o clicant el botd

&

Selecciona una part del text

[

Destaca un text determinat. Podeu seleccionar el

@ Yellowv

. Ens permet afegir el text al Notebook

color a

i

[=]

Crea una nota alla on tingueu el cursor

11
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ke v @ A (O Opcions de format com augmentar la mida de la lletra o girar

E Descarrega el PDF al vostre ordinador
E Cerca dintre del PDF

u Els PDF es poden exportar amb anotacions si anem al panel de la dreta i a Files cliquem sobre

nPodeu compartir el document amb un grup perqué tots els membres puguin veure les notes. Aquestes sén
visibles des de la columna de la dreta a la pestanya Annotations.

uDos membres d'un grup poden editar de manera simultania un mateix PDF i, quan sincronitzin tots dos,
podran veure les modificacions introduides per altres.

GES pot veure la ruta dels PDF dintre de I'ordinador: C:\Usuarios\XXX(on X és el nom de I'usuari dins el
PC)\AppData\Roaming\Mendeley Reference Manager\userfiles.

6. Llistariinserir la bibliografia en un text

6.1 Mendeley Cite

Mendeley Cite és un complement per a Microsoft Word; compatible amb Office 365 (en Windows i
Mac), Microsoft Word 2016 i posteriors, i amb I'aplicacié Microsoft Word per a iPad.

El podeu instal-lar des de la pagina Tools  Help
https://www.mendeley.com/reference-

management/mendeley-cite o des del Reference
Manager a Tools = Install Mendeley Cite for Install Mendeley Cite for Microsoft Word

Microsoft Word Search for articles online

Install Mendeley Web Importer

Check for duplicates

Un cop instal-lat quan obriu el word el trobareu a la
pestanya Referéncies.

12
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1. Perinserir les citacions en un text cliqueu sobre @
la icona de Mendeley Cite. S’obrira un panell a la
dreta del vostre document on, un cop Mendeley
identificats, veureu les vostres referéncies. Cite

2. Per defecte es veuen totes les referéncies, pero - Cite with Mendeley &
al desplegable podeu escollir una col-leccié Mendeley Cite v X
concreta. També teniu un cercador per cercar
referéncies. References Citation Settings &3 -

3. Ala pestanya Citation Settings podeu canviar
I'estil de citacié (Change c:ltatlon style) en. Neuromarketing 2
gualsevol moment. | també podeu cercar i
descarregar altres estils clicant a Change citation
style. També podeu canviar la llengua de citacid L Search for references to add...
amb Change citation language.

Es poden inserir una o diverses citacions alhora. (] Neural correlates of the non-

5. Un cop seleccionada una referéncia veureu la optimal price: an MEG/EEG study
citacio a la part inferior del panell; si cliqueu a Gorin A, Kuznetsova E, [...] Shestakova A
sobre la podreu editar, afegint pagines, prefixos gf}ggﬁgﬁs IN HUMAN NEUROSCIENCE
o sufixes i esborrant I'autor o I'any. El mateix
podeu fer un cop inserida la citacié al text, |
clicant a sobre. També podeu editar la citacio Stimulus-Informed Generalized
manualment. Canonical Correlation Analysis for

o Group Analysis of Neural

6. Un cop fetes les citacions, aneu a la pestanya ... Responses to Natural Stimuli
(part superior dreta) per inserir la bibliografia Geimaert S, Yao Y, [...] Bertrand A
(Insert Bibliography) o fusionar diferents IEEE JOURNAL OF BIOMEDICAL AND
citacions. Cal posicionar el cursor on voleu HEALTH INFORMATICS (2025) 29(2) 970-

ubicar la bibliografia. 983

7. Sien el futur canvieu la informacid d’una citacio |
al Reference Manager (per exemple, canvieu
I'autor o la data) el sistema I’actualitzara

automaticament al vostre document.
Insert 1 citation Cancel v

. [

Geimaertetal. 2025 x

6.2. Llistar la bibliografia

e Primer heu de seleccionar les referéncies que voleu llistar des de Mendeley Reference Manager o
Mendeley Web. Es poden seleccionar totes les referéncies a All references o totes les referéncies
d’una carpeta o només algunes.

e Un cop seleccionades les referéncies, apareixen a la part inferior de la pantalla diversos botons;
seleccioneu Copy As i triar Formatted Citation o Ctrl + C.
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e Obriu el processador de textos i enganxeu-les on us convingui amb Ctrl+ V
Per canviar I'estil de citacié heu de triar-lo abans des de Copy As i després Change Citation Style.

Una vegada llistada la bibliografia amb un estil si voleu canviar I'estil haureu de fer tot el procediment de nou.

7. Treballar en grup

Els grups us permeten compartir informacié i col-laborar amb altres usuaris de Mendeley.

Només els membres veuen el contingut.
Qui? El propietari del grup pot editar les caracteristiques i esborrar-lo.
L'administrador pot editar les caracteristiques pero no pot esborrar-lo

Que? Referéncies i text complet

Permet Compartir en privat documents i notes

Ideal per Grups de recerca

Afegir-se Els membres del grup poden convidar altres usuaris Mendeley

7.1. Crear grups

e Per crear grups a la Columna esquerra = Groups = Create Group

e Per convidar altres usuaris Mendeley al grup: botd dret del ratoli sobre el nom del grup a
Manage group

e Per afegir referéncies i/o PDF als grups vegeu el punt 5.1.3 Copiar, marcar favorits, exportar i
esborrar referéncies (pag. 9). Es poden afegir col-leccions als grups amb el boté dret del ratoli =
New collection

e Treballar conjuntament amb documents en un grup: tots els membres poden afegir referéncies i
documents al grup i utilitzar les funcions de ressaltat, anotacid i creacié de notes. Totes elles son
visibles per la resta de membres. També es pot assignar un color a cadascu per ajudar a
identificar-les. La pestanya Annotations de la columna dreta permet veure tots els comentaris
dels grups i permet anar a la ubicacié especifica d’'un comentari en concret.
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n Amb el compte MIE es poden fer fins a 1000 grups amb un maxim de 100 membres cadascun

ﬂ L'espai d'emmagatzematge per a grups és de 100 GB; |'espai compartit dels grups només es
descompta a la persona que ha creat el grup, no als altres membres. Per veure I'espai d’emmagatzematge
aneu a Mendeley web: Settings = Subscription = Group | own

n Les referéncies i PDF adjunts que es posen a les carpetes del grup queden separades de All References.
Aix0 implica que podrieu tenir documents duplicats

ﬂ Si copieu una referéncia de All References a una carpeta d’un grup, |'original esta a All references i al
grup es crea un duplicat. Les modificacions que feu a la referéncia o al PDF adjunt només es veuran on
s’hagin fet.

n Més informacid: www.mendeley.com/guides/private-groups

8. Sobre els drets d’autor

Cal respectar les llicencies dels proveidors a I’'hora de fer publics els articles. Respecte als grups
privats vinculats al CSUC, en general es poden compartir articles per a usos academics i no
comercials. Cada usuari és responsable de I'Gs de la documentacié que posa a Mendeley, no la

institucio.

uMés informacid: www.mendeley.com/terms/
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